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Welcome to the Online World of Education at
Flint River Technical College!

Flint River Technical College’s (FRTC) online courses free students from the requirement to be in a
specific classroom at a specific time. Students log on and work on the course weekly at the time and
place of the student’s choosing! The course number credits earned, and content covered are the same as in
a face-to-face classroom. The difference is that content is delivered via the Internet (using the ANGEL
Learning System) and students learn on computer at home!

Online classes are not easier or watered down versions of the face-to-face course. They are as rigorous
and in some cases a better learning environment for the working student. Online learning courses are not
for everyone. Some people learn best by interacting face to face with the instructor and other students. To
be successful in an online course, students should be self-motivated and work well independently.

Online courses can give learners access to courses on required scheduled courses, connect learning with
real life, offer access to massive amounts of information, allow tailored instruction, allow retrieval of
previously covered material, and provide experimenting in a safe environment.

Flint River Technical College offers many courses online and web-enhanced. FRTC’s vision is to
provide both the local and the global community with access to an affordable, diverse, and relevant
variety of high quality online training and educational opportunities.

Flint River Technical College looks forward to working with learners online!

Director of Online Learning
Elaine B. Denham
Flint River Technical College
edenham@flintrivertech.edu
706.646.6323
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Basic Skills Needed for Online Learning

The following questions assess the basic skills and capabilities that are needed in order to be successful in
an online course:

Comfortable using computers?

Personal access to technical support if technical difficulties with hardware/software arise?
Access to the Internet at home or access easily on a regular basis?

Good reading skills?

Self-disciplined, independent learner?

Use email regularly and know how to send attachments with email?

Fairly comfortable using word processing software?

Use the Internet regularly at home or at work?

Have enough time to work on and be successful in an online course considering professional and
personal schedule?

Comfortable with asking questions online?

Willing to actively interact with classmates and instructors through an electronic environment?
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Basic Skills Email Skills
o Familiar with the operating system e Send, open, reply to, and forward a
of the computer being used to access message
the Internet course e Enter a message subject
e Understand terms e Send an attachment
such as mouse, » Open and/or save an attachment
drag, open,
select, file, Web Browser Skills
choose, double- e Go to a specific URL
click, download, e Print a page
upload, send, etc. e Follow a hypertext link
e Save, copy and find e Conduct a basic search using a
files/folders on floppy search engine
and hard drives e Download and install plug-ins
o Navigate between
two or more Word Processor Skills
applications without ¢ Open a new file
closing and re-opening e Open an existing file
(multitasking) e Save afile
¢ Minimize/maximize Windows ¢ Rename a file (Save As)

e Cut, paste, format text
e Print a document

Basic Hardware/Software Needed for Online Learning

Easy access to computer at home, or wherever course work will be completed, and a direct connection to
the Internet will be needed to complete an online course.

1. Check your browser and download software that is needed: Browser. Make sure you are using Internet
Explorer 7.


http://www.gvtc.org/blackboard/browsercheck.aspx

2. Download media so that you can hear and see all content: Media Downloads

3. On your computer, go to
Start > Control Panel > Internet Options > Security > Use Pop Up Blocker > Disable
Start > Control Panel > Internet Options > Security > Trusted Sites > type in

https://gvtc.angellearning.com > Uncheck the Require Server Verification (https:) for all sites in this
zone option.

Start > Control Panel > Internet Options > Security Tab > Custom Level > Scripting > Allow status bar
updates via script > Enable.

Start > Control Panel > Internet Options > Delete Browsing History. Do this daily.

Internet Service Provider

An ISP is a company that provides the software necessary for getting onto the Internet. Students should
contact a local ISP to set up a personal account. Without an ISP, it is impossible to take online courses.
Students have reported numerous problems when using AOL to access online courses. If you use AOL,
you must be able to access Firefox or Internet Explorer. Do not use the AOL browser!

+» Specific software requirements may be necessary for certain courses. Check with the online
facilitator as to what software might be needed to be successful in that course.


http://lor.gvtc.org/uploads/SEE584/index.html
https://gvtc.angellearning.com/

FRTC’s Online Student Orientation and READI Assessment

Beginning Summer Quarter 2007 (200801), all students who are interested in taking online or hybrid
courses and have not successfully completed an online or hybrid course or SCT 100 must complete the
non-credit/non-cost Online Orientation course and READI assessment before they will be allowed to
register for an online or hybrid course.



FRTC’s Online Agreement

Once students have decided that online learning is for them, they should contact their advisor to register
for the course and read and sign Flint River Technical College’s Online Course Agreement.



Online Course Agreement 2008-2009

Student Name Student ID

Quarter: Su Fa WiSp 20 Program

CRN Course Number Course Name
CRN Course Number Course Name
CRN Course Number Course Name

You have enrolled in one or more on-line courses at Flint River Technical College (FRTC). This means
that you will not attend class on the campus of FRTC for this course. The course requirements can be
completed anywhere you have access to the Internet. The FRTC main campus library in Thomaston provides
access to computers during the day and evening. FRTC also has computer labs in Butler and Talbotton.
Public libraries have access to the Internet.

If you have not successfully completed an online course or SCT 100, you must complete the OLO 099 -
Online Learning Orientation (CRN 20212).

You must email your instructor every day for the first 4 days of the quarter. Use your FRTC student email
account to email your instructor and participate in this course. If you have not set up your FRTC email
account, please use the instructions that follow this form to do so. Your online instructor will communicate
with you using this email account, so make sure to check it on a regular basis.

Some courses such as SCT 100 require additional software on your home computer to complete the
course. Currently, the Microsoft Office 2007 versions of Word, Excel, and Access are required for SCT
100, BUS 101, BUS 108, BUS 201, BUS 105, BUS 202, CIS 127, CIS 2228, and CIS 2229.

In order to remain active in a course and not be dropped, students must check the online course classroom
at least 3 times weekly to receive updates to the schedule and to be considered active. Students must complete
and submit the required work to the instructor by the due date.

Please indicate your understanding of the requirements of this course below.
| am capable of completing the following tasks on a computer.
1) Using a search engine for research
2) Using a word processing application to submit assignments
3) Using the Windows cut and paste functions to copy information from one document to another

4) Downloading and installing Internet components such as Macromedia or Windows, Media Player or
Adobe Acrobat

5) I have access to the required software for the course.

You must access this course on the first day of the quarter. You must message or email your instructor
by the 3rd day of the quarter!

From your Internet browser software, enter the following URL, website address and click the GO button or
press enter, https://gvtc.angellearning.com/ . The first screen that you are presented with is a logon screen. A
logon user identification and password have been set up for you.

The ANGEL USERID and Password is 47_XXXXXXXXX (X=9-digit Flint River Technical College ID)

If you have questions, please call your instructor at the number listed on your syllabus. If you decide to drop
this course, you must initiate paperwork, notify your advisor and contact Student Affairs at 1-800-752-9681.

9


https://gvtc.angellearning.com/

If you are unable to successfully login to our course, please call our Director of Online Learning, Mrs. Elaine
Denham, at 706-646-6323 or email her at edenham@flintrivertech.edu.

Drop/Add Policy

Instructional Day Policy Applied

Before Day 1 of Quarter All fees must be paid or student will be purged from system

Drop Course(s) Only:
No Harm No Foul Period
» Must officially withdraw from course(s)
> No grade issued
Days1-3 » 100% refund of applicable tuition and refundable fees
Drop/Add Course(s):

If credit-hour total does not change

» No grade for dropped course
» No additional tuition paid

May add open sections of course(s)
If dropping course(s):
Days 4 -7 » Must officially withdraw from course(s)
» Grade of W issued
» No refund of tuition or fees

Can no longer add course(s)

If dropping course(s):
Days 8 — midpoint of » Must officially withdraw from course(s) (WF issued if
quarter not officially withdrawn)

> Grade of W issued
> No refund of tuition or fees

WP — Assigned when student officially drops a class after the
midpoint of the quarter and through the 30" day of the course and is
passing the coursework assigned thus far. Hours attempted are
included in Total hours. There is no effect on GPA.

Midpoint — 30" Day WF — Assigned when student officially withdraws after the midpoint
of the quarter or after the 30" day of the quarter and is not passing
the coursework; also assigned when student is withdrawn for
excessive absences. Grade carries zero (0.0) grade points and is
calculated in the GPA.

It is the student’s responsibility to make sure that all paperwork for official addition of or
withdrawal from all courses is initiated. Please follow up with the Registrar’s office to make sure all
paperwork has been completed and processed. Without official withdrawal paperwork from the
student grades for withdrawn courses will be an F.

I understand and accept the responsibility of enrolling in an online course.
Date:

(sign name here)

FRTC Email Address:

Evening phone: Day phone:
10
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FRTC Student Email Accounts

Once students have registered for their first course at FRTC they are assigned an FRTC student email
account. The following instructions tell how to access and set up FRTC student email accounts. Flint
River Technical College Student Email is the official communication method adopted by the College and
will be used for any email communication with and from advisor/instructors/FRTC personnel. This
account should be checked on a regular basis.

11
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Accessing FRTC Student Email

To login to student email, visit https://exchangelabs.com/owa

You should now see a login screen similar to Figure 1.

a. In the Windows Live ID field, enter your Live ID (this should have been
provided to you by your advisor). The format of the ID should be
firstname.lastname@student.flintrivertech.edu (e.g., Jane Doe’s Live ID would

be jane.doe@student.flintrivertech.edu).

b. Inthe password field, enter the default password “student”. Unless the PC
on which you are checking your email belongs to you it is recommended that
you do not select either “Remember me on this computer” or “Remember my
password”.

Upon your first login you will be prompted to enter account information (see
Figure 2).
Complete the requested information and click “l accept” to proceed.

Reenter your login information, this time using the new password that you
setup in the previous step. When Figure 3 appears, click the dropdown and
select “Eastern Time” as your time zone. Click OK.

7. Congratulations! You have successfully setup your Flint River Technical
College student email address. If you have any questions contact the
Live@edu Technical Support at LiveEduAdmin@student.flintrivertech.edu

Where do I check my e-mail? Sign in at
http://exchangelabs.com/owa with your new e-mail address, e.g.

firstname.lastname@student.flintrivertech.edu

nnnnnn

Sign in

& Windows Live 1D:
(sxamplesss@hotmail.com)

Password:

sezsors. Afte you g on, yeu can madfy S chace at any e
0 the Cptons page.

W Use ®re bind ared o vason experience.

Chooe the crmer y language for Mcrosoft Outiook Vieb Access. The e
determnes the e the crogram el use for i e

e

Current trwe 2o

| @rroso0)Pacic Tme WS BCanods)  ~ |

Bl cannacted to marosoft Exchange
€ 308 Micemch Coreraton. Al e e vnt.

Figure 3

M & trbox

4 [ coreFonesestant ntieeheds Shhes - - B X 3
e [
4 Contacts
2 Detdens
fj e ArangeBy: Date + Hey
am There are oitems o showin tis
[ nkewal
(3 otes
3 Outbox
[Qsetliens

Fras

Please contact George Flowers (gflowers@flintrivertech.edu) or Elaine Denham (edenham@flintrivertech.edu) if you have problems accessing your
account.
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FRTC’s Online Student Attendance Verification

In order for students to be counted in attendance in an online course, they must log into that course at
least three times per week. Login dates and times are what will be used to determine the amount of time a
student has attended/missed or to determine the last date of attendance. Also, an instructor may choose to
drop students because course work is not being submitted or is not being submitted in a timely manner.
Check the online course classroom daily for announcements and postings. The same attendance policy
applies to online courses as that used in on campus courses.

Attendance

The educational programs at Flint River Technical College reflect those requirements and standards that
are necessary for future successful employment in business and industry. Employers expect their
employees to be present and to be on time for work each day. Likewise, Flint River Technical College
expects each student to be present and to be on time for every class.

A student is considered to have an unsatisfactory attendance record if absent more than 10 percent of the
scheduled contact hours for a class. If absences exceed 10 percent, the instructor will notify the student
that further absences jeopardize continued enrollment in the class.

An absence rate of twenty percent or more of scheduled contact hours for a class REGARDLESS OF
THE REASON will result in dismissal of the student from the class(es) unless the average of all grades
received in the course is 80 or above. With each additional tardy or absence, the students average will be
re-evaluated. If at any point of evaluation, the average falls below 80, the student will be dismissed from
the class with a grade of WF. Readmission will follow the general admission policy. A tardy is being out
of the class for ten minutes or less in a scheduled contact hour. An absence is any time out of class in

excess of ten minutes. Four tardies equate to one absence.
STUDENTS WHO ARE DISMISSED FOR EXCESSIVE ABSENCES WILL AUTOMATICALLY RECEIVE A GRADE
OF “WF” FOR THE COURSE FROM WHICH THEY ARE DISMISSED.

(Copied from 2007-2008 Student Catalog on FRTC Website)

13



Proctored Exam Policy for Online Courses
(Off Campus and On Campus Proctors)

All on line courses must have proctored midterm and final exams. The dates and times for these exams
will be published at the beginning of each quarter. Students using an off campus proctor must take
exams on the designated dates. Students using an on campus proctor must take exams on the
designated dates and at the designated times.

Students Using Off Campus Proctors

All students using off campus proctors are required to submit to the course instructor a candidate as a
proctor by the second week of the quarter. Students will not be allowed to take the midterm and final
exams without a qualified proctor. For students using off campus proctors, proctors MUST be someone
with supervision over the student, such as an instructor or employer, or someone associated with an
agency such as a public library or educational institution. Qualified proctors will have an email address
domain associated with a place of employment (i.e., proctor@flintrivertech.edu), and the proctor’s name
must be reflected in the email address. Common domain names that anyone can get will NOT be
accepted, such as Yahoo, AOL, CSV, HOTMAIL, EXCITE, ALLTEL, PEOPLEPC, NETZERO, or
BLACKPLANET. The course instructor must approve the candidate for proctor. Please notify the
instructor IMMEDIATELY if you have any problems with selecting a proctor.

All students using an off campus proctor must have a qualified proctor approved by the course instructor
by the end of the third week of the quarter. Once all proctors are approved, the course instructor will fill
out and send the form Information to be Supplied to Proctors by Online Instructors for Proctored
Exams

In order to create the best possible testing environment for students, the following policies are in effect for
online midterm and final exams on the Flint River Technical College main campus or Talbot County or
Taylor County centers:

Exams must be taken on one of the scheduled days.

Exams must be taken at the scheduled time.

Only those students who are testing will be allowed in the testing area during testing.

All students who will be testing must arrive at least 10 minutes before the designated time for the

exam to begin.

5. All students must present their current, valid Flint River Technical College student identification
badge or other valid picture identification. Students will be admitted to the testing area once the
valid picture identification is shown.

6. Only resources approved by the course instructor will be allowed in the testing area. Flint River
Technical College does not have an area to secure any items brought that are not approved. If
students show up with any resources that are not approved, they will not be allowed into the
testing area.

7. All electronic devices (cell phones, pagers, etc.) must be turned off and cannot be using during
testing.

8. Students will not be allowed to leave the testing area once testing has begun. Please make sure
that all personal needs are attended to before reporting for the exam.

9. Students will not be allowed to communicate with anyone during the exam. If there are any
guestions/problems, please raise your hand and the proctor will come to you.

10. Students who violate any of these policies will not be allowed to finish the exam and will be

referred to the proper college official for disciplinary action.

PR
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Students Using On Campus Proctors

In order to create the best possible testing environment for students, the following policies are in effect for
online midterm and final exams on the Flint River Technical College main campus or Talbot County or
Taylor County centers:

1.
2.
3.

o ks

10.

11.

12.
13.

Exams must be taken on one of the scheduled days.

Exams must be taken at one of the scheduled times.

On the main campus, all midterm and final exams will be delivered and proctored in the library’s
computer lab or in the Plato Lab. The Talbot and Taylor centers’ location will be determined by
the proctor at that location.

Only those students who are testing will be allowed in the testing area during testing.

All students who will be testing must arrive at least 10 minutes before the designated time for the
exam to begin. The door will be closed at the designated time and no one will be admitted to the
testing area after this.

All students must present their current, valid Flint River Technical College student identification
badge. Students will be admitted to the testing area once the ID badge is shown.

All students must sign in giving the date, time, course number(s) and instructor’s name(s) of
exam(s) to be taken, and Flint River Technical College Student ID#. Student will sign and
proctors will check student IDs.

Only resources approved by the course instructor will be allowed in the testing area. Flint River
Technical College does not have an area to secure any items brought that are not approved. If
students show up with any resources that are not approved, they will not be allowed into the
testing area.

All electronic devices (cell phones, pagers, etc.) must be turned off and cannot be using during
testing.

Students will not be allowed to leave the testing area once testing has begun. Please make sure
that all personal needs are attended to before reporting for the exam.

Students will not be allowed to communicate with each other during the exams. If there are any
guestions/problems, please raise your hand and the proctor will come to you.

As space allows, there must be at least one desk between each student taking exams.

Students who violate any of these guidelines will not be allowed to finish the exam and will be
referred to the proper college official for disciplinary action.

Approved On-campus Proctors

Following are the approved on campus proctors:

Director of Library/Media Services (or designee)
Director of Online Learning (or designee)

Deans for Academic Affairs (or designee)
Director of Information Services (or designee)
Learning Support Instructor

15



Getting Connected
Logging into ANGEL

Students will first need to access the ANGEL web site using the URL:
https://gvtc.angellearning.com

[:; ANGEL Learning - Windows Internet Explorer

@.\T};v |@ http: ffgvte. angellearning, comf v| hedll |

File Edit View Favorites Tools  Help
Links @& | Customize Links & | Free Hotmail & | Windows &0 windows Marketplace & | windows Media

Google [Cl» viGoog) B » 99 Bookmarksw PRk o [Ehsoblocked | U Check v % Autolink v [ab sendtor () settings -
—_— — s »
Wk [@F\NGEL Learning l l M v B o= v bPage - (0 Toos -
2

Georgia Virtual Technical College

A ynit gf the Techrical Collzge System of Cegrgia

Public Announcements - [

Sunday, June 29, 2008

1 fargot my password

Welcome to the ANGEL 7.3® Student Escentials Guide; click here to open. This guide is designed te provide
Search and He'D students with a basic understanding of ANGEL and its primary tools. ANGEL is a Web-based course management
and collaboration portal that enables educators to manage course materials and to communicate with students.
Help (a7 ANGEL can function both as a complement to traditional courses and as a site for distance learning. With ANGEL,
Guided Tour & wou can take surveys, quizz_es, and tests; senc! and receive course mail; post messages to threaded discussions
and chat rooms; upload assignments using online drop boxes; and more. You can check your progress and
grades at any time during a course.

Saturday, June 23, 2008
@

Py& Support

1. If you are having difficulties with your Angel online courze, make sure you are aware these
requirements. See Computer Needs cn this page and update your computer.

2. If vour computer mests all cequirements, has nopouns =pabled, and bas all media downloads, bit voy ace -

Done & mternet H100% -

Welcome to GVTC and Angel

mp— = - - — = =
2 start ®rb. | 2 Ha. B AL den., | TR | @A, EEe @

They will then need their username and password. The following information will be used to determine
what their username and password will be for logging into their ANGEL account:

Username: 47_XXXXXXXXX (FRTC 9-digit student ID)
Password: 47 _XXXXXXXXX (FRTC 9-digit student I1D)
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Once they have accessed the FRTC ANGEL portal, they should see a screen that looks like
this:

ﬁ ANGEL Learning - Windows Internet Explorer

@;.’v |g http: ffgvte. angellearning, comf v| hedl |

Fie Edit View Favorites Tools Help
Links @& | Customize Links @& | Free Hotmail & | Windaows B0 Windows Marketplace & | Windows Media

Google (Gl+ viGoo ) B » 9 Bookmarksw PRk o [Ehcpplocked | 5P Check v o Autolink » [ab Sendto () settings -
|52k Page » ) Tools - »
2

[ u]

w o [@ANGELLeaming l_l -8

Georgia Virtual Technical College

AUnit f the Techrical College System of Gegrgia

Tech Flint ¥

Edit Page Refresh

Public Announcements

View: Past Present All | Sort: Descending

There are no new announcements.

Today's Calendar

Find a Course No. Add a Course Mo, ~ V_’iew Inbox Quick Sort by: Date Section Categery | Show Motes
UJFlint Conversion ! View, read, and Message POC Group Flint River Schadula
Role: Student compose i i
oek : S " Skip the inbex and @ July 15 - Last Day to Add Classes
Tasks: A QEScsSge start your message. Categery: Reminder

OTraining @ July 15 - Last Day to Add Classes

Role: Student o Category: Reminder
e Unread Messages e

@ Summer Quarter Bagins
Cstegery: Reminder

All 0 messages

Community Groups

|

@ summer Quarter Begins
Category: Reminder

@ July 11 - Last Day to Drop Classes
Category: Reminder

@ July 11 - Last Day to Drop Classes
Category: Reminder ¥

Done & mternet H100% -

[ e—— - - —
12 start ®mnb.. | /2 Bha.. Ora.. | {2 &M... 72 AN, M., at... | TYFRT.. ... EEo@E0 0,

Students who have problems logging should contact the Director of Online Learning.

The courses in which students are enrolled in ANGEL are on the left. Please click on the course to enter
the ANGEL classroom.
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Properly Configuring Browser Settings for ANGEL

Students should always check to make sure their computer settings are properly configured for ANGEL.
They can do this by using the Computer Needs on the first page of ANGEL.

f.:; ANGEL Learning - Windows Internet Explorer
@;: - |E http: ffgvte. angellearning. com) V| Sl | | P~

File Edit ‘Wew Fawvorites Tools Help
links @ | Customize Links g | Free Hotmail @& | Windows B2 Windows Marketplace & | Windows Media

GDCngC |Cv | GO @ g - {:? Bookmarks = F."’Lﬂf - @52 blocked ﬂ?‘ Check ~ % Autolink - h | B Sendtow | @ Settings -
52? & [@ANGEL Learning l_l ﬁ - E] Qé; - ijage - Q} Todls +
g

Georgia Virtual Technical College

Aynit ¢f the Technical College System of Gagrgia

If wvou are having difficulties with your,
requirements. See Computer Neeg

ngel online course, make sure you are aware these
on this page and update your computer.

2. If your computer meets all requirdments, has pop-ups enabled, and has all media dewnloads, but you are
still having trouble accessing argas of your Angel course, contact your instructor.

3. If your computer meets all reffuirements and your instructer is unable to help vou with technical support,
ask your instructor to contacyf your College's GVWTC Coordinator. This keeps communication open among
you, the student, the instrugfor, and the College’s GWTC Coordinator.

4. If your computer meets allfrequirements and your instructer and GVTC Coordinator have not been able
to resclve your technical gupport issue, reguest that it is elevated to the GVWTC HelpDesk.

Saturday, June 28, 2008
@

1. Check your browger and download software that is needed: Browser. Make sure you are using
Internet ExploreN?’

2. Downlcad media so that you can hear and see all content: Media Downloads.
3. ©n your computer, go to

o Start = Contrel Panel = Internet Cptions = Security = Use Pop Up Elocker = Disable

a

Start = Control Panel = Internet Options > Security = Trusted Sites = type
in http://gvtc.angellearning.com = Uncheck the Require Server Verification (https:) for all sites
in this zone option.

=1

Start = Control Panel = Internet Options > Security Tab = Custom Level > Scripting = Allow
status bar updates via script = Enable.

o

Start = Control Panel = Internet Options > Delete Browsing History. Do this daily.

Done G Inkernet . <
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Work Ethics

All online courses will assign a work ethics grade.
Flint River Technical College Learning Resources

Flint River Technical College offers library services to provide quality academic library resources and
services in support of FRTC’s Associate of Applied Science, Diploma, Certificate, Adult Literacy,
Continuing Education, and Economic Development programs.

These resources consist of three online services that students may access on the College’s library web
page at http://www.flintrivertech.edu/library.

GALILEO (Georgia Library Learning Online)

The most comprehensive selection of electronic learning resources available to FRTC students is grouped
into a single website referred to as Georgia Library Learning Online (GALILEO) -
http://www.galilieo.usg.edu. GALILEO is a statewide electronic library operated by the University
System of Georgia, which is available to all Georgians through the internet. Presently, over 100 databases
are available through GALILEO to Georgia technical colleges.

GALILEO databases provide citations and full text articles related to current events, business, general
interest, popular and scholarly topics, science and technology reference sources, regional current events,
and business and management topics, as well as health and social science citation, abstract, and full text
articles. These resources include the following: 16,000 electronic books at netLibrary, the Encyclopedia
Britannica Online, and the Newsbank Atlanta Journal-Constitution and Georgia Newspapers.

NetLibrary

FRTC provides access to over 15,000 electronic books (eBooks) through NetLibrary, including reference
books, scholarly monographs, publications of many university presses, and consumer books that have
been converted into digital format. It is possible to perform full-text searches of a single eBook, search
thousands of volumes simultaneously, browse topic categories, or read eBooks directly online. There is
no checkout period for NetLibrary eBooks.

Users can create an account in order to use personalization tools, including creating a Favorites list, but a
personal account is not required for accessing eBooks through the GALILEO interface. A personal login
is required when accessing through library catalogs and through the NetLibrary web site.

Library Catalog

This online service searches FRTC’s collection of resources by author, title, subject, keyword, or visual
navigation.

Please obtain and keep for future reference a copy of the Student Library Handbook.

Additional Information
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Some courses such as SCT 100 require additional software on home computer to complete the course.
Microsoft Office is required for several courses taught online. Please contact the instructor for that course
for the version of Microsoft Office required.

Students must check the online course classroom to receive updates to the schedule and to be considered
active. Students must complete and submit the required work to your instructor by the due date.

The FRTC main campus library in Thomaston provides access to computers during the day and evening.
FRTC also has computer labs in Butler and Talbotton. Public libraries have access to the Internet.

Trouble Shooting Advice

There may be times during course enrollment that students encounter technical problems.
Listed below are resources to assist students. The FRTC technical support staff aims to assist
students in a timely manner and is here to support them with technical problems they
encounter during the quarter.

Students should visit the Frequently Asked Technical Support Questions (FAQS)
beginning on page 23 section before contacting tech support. Answers to questions may be
found in that section.

Course/Grade/Assignment Questions

Students should contact their instructor via email or telephone. Also, the instructor is the first point of
contact for resetting any tests.

ANGEL Log-in Problems

Mrs. Elaine B. Denham, Director of Online Learning, Flint River Technical College
edenham@flintrivertech.edu or 706.646.6323
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To add ANGEL to your Trusted Sites.
¢ While in Internet Explorer, on the menu bar, click on Tools and then click on Internet Options
In the Internet Options dialog box click on the Security Tab.
Click on Trusted Sites. (The green checkmark.)
Click on Sites.
Remove the checkmark from "Require server verification (https:) for all sites in this zone™
Enter gvtc.angellearning.com in the "Add this web site to the zone:" box.
Click Add
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Frequently Asked Questions

This FAQ provides answers to commonly asked questions about using
ANGEL.

1. Where is ANGEL?

ANGEL is a course management software company that provides the course
“shell” for all online classes taught within the Georgia Virtual Technical College,
a partnership in which Flint River Technical College is a member. You access the
site by going to https://gvtc.angellearning.com. Questions about the Georgia
Virtual Technical College can be answered at their FAQ site at
http://www.gvtc.org/fag.asp .

2. What software do students need to access their ANGEL course?

A web browser — Firefox 3 or higher, or Internet Explorer version 7 or higher, with JavaScript
and cookies enabled. Students may check the browser's Help files for more details. Mac Netscape
users will need to download a plug-in that forces Netscape to use Apple's "Macintosh Runtime
Java" for use with the Virtual Classroom feature. This is available for download from:
www.mozilla.org/oji/MRJPlugin.html.

Students can download the latest version of FireFox or Internet Explorer from free downloads.

Students should not use AOL as their web browser. They should use either Internet Explorer or
Firefox.

Students must use their Flint River Technical College student email account. This is required to
take any online course at Flint River Technical College.

Associated programs, viewers, and plugins recommended by the course instructor (eg. Word,
Excel, Acrobat Reader).

Instructors may include links to online journals and library databases within the course, such as
GALILEO.
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3. How do students login to ANGEL?

e After students are registered for an online course, they will receive a copy of the Online Course
Agreement they (see Appendix A) signed. This will contain login information.

e Students will then open their web browser, then type the following addresses in the Location box
at the top of the browser's screen: https://gvtc.angellearning.com

o  Students will then enter their username and password:

o Username: 47_XXXXXXXXX (X = FRTC 9-digit Student ID#)
o Password: 47_XXXXXXXXX (X = FRTC 9-digit Student ID#)
o Select Login. The Home screen will load.

ﬂ; ANGEL Learning - Windows Internet Explorer |:”E|[z‘

@.\:}; - |E hikp: ffigwic. angellearning. com) V| #2| X | | P
File Edit View Favorites Tools Help
Links @ | Customize Links g | Free Hotmail @ | Windows B2 Windows Marketplace & | Windows Media

Google G- viGoogd B v €% bookmarksw PRk o Ehspblocked % check » 'y Autolink v (s Sendto () settings~
w o [@ANGEL Learning li -5 & -[Erage - o~

[

Georgia Virtual Technical College

Aunit ¢f the Technical College System of Gegrgia

Public Announcements
Log on View: Past Present All | Sort: Descending
Sunday, June 29, 2008
Usernamel:l

passwora | o

1 fargot my password

Welcome to GVTC and Angel

Welcome to the ANGEL 7.3® Student Essentials Guide; click here to open. This guide is designed to provide
Search and Help students with 3 basic understanding of ANGEL and its primary tocls. ANGEL is a Web-based course management

and collaboration portal that enables educators to manage course materials and to communicate with students.
Help = ANGEL can function both as a complement to traditicnal courses and as a site for distance learning. With ANGEL,
Guided Tour & wou can take surveys, guizzes, and tests; send and receive course mail; post messages to threaded discuszions

and chat rooms; upload assignments using online drop boxes; and more. You can check your progress and
grades at any time during a course.

Saturday, June 28, 2008
” 1

B

i/ I8 support

1. If you are having difficulties with vour Angel online course, make sure you are aware these
requirements. See Computer Needs on this page and update your computer.

2 If vour computer meste all requiremeants, bae pop-une enabled and bac all media downloade bit von are bt
Done E\B 0 Internet F100% v

®mb.. |/ Ba.. Ora. | (7 AN.. 7= ... B A @an. | Tirrr.. | g@an. EMEeQ@EE
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[; ANGEL Learning - Windows Internet Explorer

@'\T_}: - |@ http: jfgvte, angellearning. com v| hedll | | 22

File Edit View Favorikes Tools  Help

Links @ | Customize Links & | Free Hotmail & | Windaws B0 windows Marketplace & | windows Media

Google (Gl+ viGoo 5D Ef » €9 Bookmarksw PatRenk o [Ehepplacked | P Check v % Autolink w - (o Sendto~ () settings -
—_— = s »

Wk [@F\NGEL Learning l l v B o= v |bPage - (0 Toos -

©
Georgia Virtual Technical College

A uUnit of the Techrical College System of Ceorgia

Tech Flint <

Edit Page

Public Announcements

View: Past Present All | Sort: Descending

There are no new announcements.

Today's Calendar

Find a Course No. Jf.cc a Course Mo, = View Inbox ): Quick Sort by: Date Section Category | Show Motes
JFlint Conversion £ View, read, and “‘ Message POC Group Flint River Schedule
Role: Student compose - :
OET(:. = ___=me Skip the inbox and @ July 15 - Last Day to Add Classes
Tasks: |2 QEScsSge start your message. Categery: Reminder
U Training ﬂk @ July 15 - Last Day to Add Classes B
Role: Student i Category: Reminder
e Unread Messages @ ==
Summer Quarter Begins
All 0 messages T s

Category: Reminder

Community Groups @ summer Quarter Begins

Category: Reminder

@ July 11 - Last Day to Drop Classes
Category: Reminder

@ July 11 - Last Day to Drop Classes
Category: Reminder

b

Done & mternet F 100 v
——— = = :
2 start ®mnb.. | /B Ora.. | {2 &M... 72 ...

AN, AN, TY FRT... AN, EEO@EO Y,

4. Students are enrolled in more than one course at a college using ANGEL. Do they need more than
one ANGEL account?

Students have only one ANGEL account for each college, which is used to access all ANGEL courses in

which they are enrolled at each college. If students are taking courses from multiple colleges, they will
need a log in for each college.

5. ANGEL is not responding, who do students notify? How long before it is working again?

When students are sure that the problem isn't that they are trying to login with an incorrect username or

password, contact the Director of Online Learning at Flint River Technical College: Mrs. Elaine
Denham at 706.646.6323.
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6. How do students logout of ANGEL?

e Students will select the Logout button, located in the Navigation bar to the left of the ANGEL
screen.
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Accessing FRTC Student Email

To login to student email, visit https://exchangelabs.com/owa

You should now see a login screen similar to Figure 1.

a. In the Windows Live ID field, enter your Live ID. The format of the ID should
be

firstname.lastname@student.flintrivertech.edu (e.g., Jane Doe’s Live ID would

be jane.doe@student.flintrivertech.edu).

c. Inthe password field, enter the default password “student”. Unless the PC
on which you are checking your email belongs to you it is recommended that
you do not select either “Remember me on this computer” or “Remember my
password”.

Upon your first login you will be prompted to enter account information (see
Figure 2).
Complete the requested information and click “l accept” to proceed.

Reenter your login information, this time using the new password that you
setup in the previous step. When Figure 3 appears, click the dropdown and
select “Eastern Time” as your time zone. Click OK.

7. Congratulations! You have successfully setup your Flint River Technical
College student email address. If you have any questions contact the
Live@edu Technical Support at LiveEduAdmin@student.flintrivertech.edu

Where do I check my e-mail? Sign in at
http://exchangelabs.com/owa with your new e-mail address, e.g.

firstname.lastname@flintrivertech.edu

Have an MSN Hmmml MSN Messenger, or Passport
cccccc

Sign in

& Windows Live 1D:
(sxamplesss@hotmail.com)

Password:

[er—"ule—"0

Figure 4

"5i: "Office Outlook Web Access

16y have s v an e e s o fh ot otings, v
can select e check box below 1 cptmiz= OuSook Web Access for #15 and sl

sessors. Afte you g on, you can modify Sie chace at any e
0 the Cptons page.

W Use ®re bind ared o vason experience.

Ghoonethe rmary languape fo Meroaoft Ok e Access The e
determnes the s the crogram wl use for o e,

R o sz

Current trwe 2o

(GH7-08:00) Pactic Twe (U5 & Canads) -

lmmmmz
Al g

Figure 3

M & I (0 s

4 {§ George Fonestshent viereheds e + B B
[
4 Contacts
3 Destedes

fj Dl Arrange By: Date +

f]]rlm There are oitems o showin tis

[gankena
(3 otes
'gom
[ sentrens

Fras

Please contact George Flowers (gflowers@flintrivertech.edu) or Elaine Denham (edenham@flintrivertech.edu) if you have problems accessing your
accouont.
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Introduction

Welcome to the ANGEL 7.3® Student Essentials Guide. This guide is designed to provide
students with a basic understanding of ANGEL and its primary tools.

ANGEL is a Web-based course management and collaboration portal that enables educators to
manage course materials and to communicate with students. ANGEL can function both as a
complement to traditional courses and as a site for distance learning.

With ANGEL, you can take surveys, quizzes, and tests; send and receive course mail; post
messages to threaded discussions and chat rooms; upload assignments using online drop boxes;
and more. You can check your progress and grades at any time during a course. You can also
create groups and teams for project or committee work.

A significant portion of ANGEL’s power lies in its ability to be tailored to specific institutional
needs. Please note that because your institution determines which tools are made accessible, some
parts of this guide may not apply to your use of ANGEL. Contact your institution’s support desk
if you have questions regarding ANGEL administration.

Special Features Used in This Manual

This document includes a variety of special features to help you master ANGEL’s features and
capabilities. Each feature is marked with an icon for easy identification. The following table
describes these features.

Icon Name — Description

Tip — A Tip helps you apply the procedures described in the text to your specific
needs. A Tip may also suggest an alternative method for performing a task, or may
explain the benefits and capabilities of a feature.

Note — A Note calls your attention to information of special importance.

Reference — A Reference points you to another source of information.

S

Caution — A Caution alerts you when an action could cause problems.

4
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ANGEL Home

The ANGEL Home page (ANGEL Home) functions primarily as the log-in screen and starting
point for each ANGEL session.

ANGEL 7.3

Home  ANGEL 7.3 - Home
Power Strip icon

Log On Today's Public Calendar
Username:l « Add / Drop Period ends Friday
Category: GeneralClass
P‘“‘“’“’l:l Course Adds / Draps must be completed by Friday.
Language| Engish (United States)
(Log0n Public Announcements [ol[]ls]
1 forgot my password
Request an account View: Past Present All | Sort: Descending
Request a Ml;r;il;zllwnts\ght Window Thursday, February 14, 2008
@ Charity Event Registration -- stop by the student union this week to sign up for a community outreach
Public Content Links [regrmt

Library Resources
Event Calendar

In the News
Public Surveys
Public Farums

Search and Help Links

Course Search
Community Search
People Search
Help &

Guided Tour &

nowered hy the ANGEL |M5”

The left edge of the ANGEL Home page is called the Power Strip; this area contains basic
system navigation tools. Other sections of the screen enable you to log into ANGEL and access
various resources.

Navigation Tools

There are three system navigation tools at the top of the Power Strip. These icons are always
available on the ANGEL Home page and when you are working in a course or a group.

The following table explains these navigation tools.

5
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Icon Name - Description
T, Home — Returns you to your home page
Z_x . #_Z Help — Displays ANGEL online help, guides, and resources
Z_ﬂ__x_i Log Off — Logs you out of the ANGEL environment

Public Resources

ANGEL Home offers a variety of public resources for instructor and students. To access a
resource, simply click its hyperlinked title.
% All these resources may not be available at your institution. Further, your
institution may offer additional customized resources.
Standard resources include the following:

e Library Resources provides access your institution’s library resources, such as
electronic journals, catalogs, and databases.

e Event Calendar provides access to your institution’s public calendar, including events,
significant academic or training dates, and other entries.

e In the News keeps you up to date on your institution’s latest news.
e Public Surveys enables you to participate in public surveys at your institution.

e Public Forums lets you join public discussions at your institution.

0" These resources are also available in the Toolbox section of your personal
k] home page.

Search and Help

The Course Search, Community Search, and People Search links enable you to find and view
any course, group, or user profile that is viewable by the general public.
e, Log into ANGEL before performing this search to view a larger selection of
a) courses, groups, and profiles, including those that have been made viewable
only to authenticated ANGEL users.
Click the Help link to access documentation or to request help from your institution’s support
desk. Take the Guided Tour to view highlights and features of the ANGEL application.

6
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Personal Home

When you log into ANGEL, your personal home page (Home) appears. Home enables you to
access all the courses and groups in which you are enrolled. The page also provides a variety of
tools to assist you with your coursework.

G

ANGEL 7.3

\_Joe Smith | ¥

Edit Page Refresh
Courses Today's Calendar My Announcements
Find 2 Courss There are no events for View: Unread All | Mark 25 read
OFi - today.
iirg_’;?uiif'at'on Thursday, February
Task;' i d —_— 14, 2008
o Toolbox )
& Charity Event
. Bookmarks Registration -- stop by
Community Groups Efee‘:;kpemin:‘ramed list the student union this
Find 2 Group Crazte 2 Group i b"':;usr = week to sign up for a
— community outreach
s program.

Upload files for easy

access from anywihere,
Calendar

Keep track of important

personal events,
Public Resources

Access respurces found

on the logon page.

To customize the selection and appearance of tools on your personal home
page, click the Edit Page link in the Home menu bar.

Navigation Tools

Your personal home page features a set of navigation tools, located in the Power Strip along the
left edge of the screen. These icons are always available on your personal home page and
whenever you are working in a course or group.

7
Personal Home



ANGEL® 7.3 Student essentials Guide

“‘Power Strip” icons

508 Accessibility &
PDA mode controls

8
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The following table describes these navigation tools.

Icon

Name - Description

."-..

Home — Returns you to your home page

Fy

Help — Displays ANGEL online help, guides, and resources

Log Off — Logs you out of the ANGEL environment

ePortfolio — Launches ePortfolio (only appears if your institution has ePortfolio
installed.)

Personal Preferences — Provides access to your user settings, such as your
personal information, password, theme selector, system settings, and PDA agent

ANGEL IM — Opens the online ANGEL instant messenger

There are two additional accessibility-related icons at the bottom of the page that function as
illustrated and described below.

Icon

Name - Description

508 — Allows you to create a profile that describes your particular needs for
accessing course material. If necessary, you can access an ACCLIP for use with
ANGEL.

The acronym ACCLIP stands for “Accessibility for Learner Information
Profile.” ANGEL’s Accessibility menu allows you to creaate, save, or import
ACCLIP profiles.

PDA — Allows you to activate ANGEL in PDA mode. Page layout and
navigation are customized to suit your selection.

Help

You can open ANGEL’s online help system by clicking the Help icon ( “2/). By default,
ANGEL’s online help system displays a searchable copy of this Essentials guide.

9
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&_{ ~
|7’ Conventions Used in This Manual I n t ro d uc t ion

Introduction ) )

Public Home Welcome to the ANGEL 7.2 Student Quickstart Guide.

Personal Home This guide is designed to provide students with a basic

Course Overview

: understanding of ANGEL and its collaborative tools.
|? Calendar Tab

|7 Lessons Tab ANGEL is a web-based course management and

|7 Resources Tab collaboration portal that helps educators manage course
l(%'Ct:rnrnuniﬁmeTab material and communicate quickly, easily, and effectively.
|7 Report Tab

ANGEL is designed to be used as a complement to

(2 Common Tasks traditional courses and for distance learning.

With ANGEL, you can take surveys, quizzes and tests,
send and receive course mail, post to threaded
discussions and chat rooms, upload assignments using
drop-boxes, and more. Students can check their progress
and grades at any time during the course and can create
groups and teams for project or committee work.

A significant part of ANGEL's power is its ability to be
tailored to specific institutional needs. Please note that
because your institution determines which tools are made
accessible, some segments of this guide may not apply to
your use of ANGEL. Contact your institution's support desk
for gquestions regarding ANGEL.

et g, r—ﬁ ey pbiitadale, |t Al i ol e e M A oy bl il
The left-hand pane of the Help window displays the Student Essentials contents. When you click
a help topic’s heading in the left pane, the topic’s text appears in the right-hand pane.

In the upper right corner of the window, three links let you access different parts of the help
system:

e The Online Help link returns you to the searchable Essentials guide.

e The Guides hyperlink opens a list of guides that are available in PDF format, which you
can download and print.

e The Resources hyperlink provides access to your institution’s resources, which can be
made available by your institution’s ANGEL Administrator.

Preferences
Clicking the Personal Preferences icon ( . ) ) opens the Preferences window. From this
window, you can customize the information about your profile and courses, change your
password (if applicable), adjust system settings, and further configure ANGEL to suit your needs.
@ The Personal Preferences icon has changed to a silhouette

image ( (%)) from the previous wrench icon ()
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ANGEL /.3

Home * Preferences

u Preferences

General User Settings

Tips You can use the Personal Information Editor to enter your contact information and configure who should be able to se= it

Personal Information
Update your personal contact information and set who can ses it

Change Password
Change your password cften to ensure your privacy.

Theme Selector
Select 2 personal theme that suits your taste,

System Settings
Update systam settings such as local drives,

The Preferences window contains the following links:

e Personal Information allows you to change your personal information and determine
who can view it.

e Change Password enables you to change your ANGEL password. As a precaution, you
must provide your current password and confirm your new password before applying the
change.

e Theme Selector allows you to select different ANGEL themes or even create your own
to change how the environment looks when you log in.

e System Settings lets you specify local media drives to map online course material to CD-
ROMs or other media for enhanced instruction. In the System Settings window, you can
also configure ANGEL to send a copy of all course mail to your favorite e-mail account.

Instant Messenger

Clicking the Instant Messenger icon (@) launches ANGEL’s built-in Instant Messenger (IM)
utility. This convenient tool enables you to communicate with other ANGEL users online, in real
time.

11
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€] ANGEL Instant Messenger - Microsoft Internet Explorer u@m
2ll Users || Hailey Longardner X
E Debbie Dillow to Hailey Longardner: b] @\ Online Users X
Hello, how's it going Hailey? - Hailey Longardner

Hailey Longardner to you:

Wery well K
TH  Debbie Dillow to Hailey Longardner:

How do you think you did on the homewaork
assignment in the Web class?

Hailey Longardner to you:
1 think I did well. It was a fun assignment.
Hailey Longardner to you:
How did you do?
E Debbie Dillow to Hailey Longardner:
1 think I did ok - it was fun!

To: | Hailey Longardner

EM

To converse with an online user, select a name from the To: drop-down list, type your message,
and click the Send button.

Courses

The Courses section of your personal home page gives you access to all the courses for which
you are enrolled, either as a student or instructor. To access a course, simply click its name;
information about the selected course appears on a new page.

Courses

Find a Course

D Documentary Film Production
Role: Student

JFilm Appreciation
Role: Student

ANGEL’s course-related tools are described in more detail later in this guide.

Community Groups

The Community Groups section of your personal home page gives you access to all the groups
you have joined, either as a student or instructor.

12
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Community Groups 2] =]}
Find 3 Group Creste a Group

dDigital Media Group
Role: Member

dMedia in the Classroom
Role: Member

-=- t‘-‘_‘-‘irﬂ‘-ﬂ --F.‘_""m

To access a group, simply click its name; information about the selected group appears on a new
page.
ANGEL’s group-related tools are described in more detail later in this guide.

Toolbox

The Toolbox section features tools that can increase your productivity and further customize your
ANGEL environment.

Toolbox

Bookmarks
Keep a personalized list of bookmarks for sasy
access to your favorite sites,

Files

Upload files for easy access from anywhere,
Calendar

Keep track of important personal events.
Public Resources

Access resources found on the logon pege.

The Toolbox contains the following links:

e Bookmarks lets you place links to your favorite Web sites on your personal home page.
You can also sort your links by category, and set permissions for individual bookmarks to
make them accessible to other ANGEL users.

o Files enables you to set up folders and create text files, and to upload documents and
images for storage. You can also use ANGEL’s built-in HTML Editor to create new Web
pages or edit existing ones with an easy-to-use word processor-style interface.

e Calendar lets you view or add personal calendar events or public institutional events.

e Public Resources provides the resources found on the ANGEL Home page.

Course Mail

The Course Mail section functions like most other e-mail programs: it enables you to exchange
e-mail messages with other ANGEL users.

13
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iy View Inbox Quick Message
! View, read, and compose “ Skip the inbox and and
messsges start your message.

o
L_]Unread Messages
Film Appreciation (101) 0 messages

The Course Mail section contains the following three options:
¢ View Inbox opens the Course Mail application and shows all the messages in your inbox.
e Quick Message lets you bypass the inbox and start composing a message.

e Unread Messages displays a count of unread messages in your inbox.

14
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Course Overview

ANGEL’s course-related tools enhance the learning and collaborative experience and make it
easy to manage many aspects of your courses.

To access a course, click its name in the Courses section of your personal home page. When the
course opens, you can navigate the course-related information by using two different sets
navigation tools: the navigation tabs or the course guide. These navigation tools are described
briefly in the following sections.

Navigation Tabs

When you access a course, a set of navigation tabs appears across the top of the ANGEL
window. Click a tab to view a page containing one or more specific types of information about
the course. As you navigate through the tabs, the Bread Crumb frame updates to show your
current location within the course-related information.

Navigation Tabs

Bread Crumbs

Fim Appreciation

| ""'—'1 Calendar

ome * Course

Lessons l Resources |Communkzte| Report

: . @) Film Appreciation
oexpand @ collapse
it TM*"*_‘&M“‘“’-'W“‘--\M‘«.W,w oo WL o

The following tabs are available for each course:

The Course tab is the “dashboard” into your course. The tools on this tab let you see your
level of participation in the course, check your grades, view discussions and
announcements, and perform other basic tasks related to the course.

The Calendar tab displays events that have been assigned or Milestones within the
course (such as exams or assignment due dates).

The Lessons tab provides access to all the lessons that have been created and posted for
the course.

The Resources tab provides a set of helpful resources made available by the course’s
instructor. These items can include a syllabus, links to Web sites related to the course,
institutional resources such as library records, a Web search tool, and others.

The Communicate tab displays tools that let you communicate with others in the course
via e-mail and discussion groups. The tab also provides a course roster and displays any
course related news, events, or announcements.

The Report tab’s tools enable you to generate and save various types of reports related to
the course, such as reports on your grades or course milestone achievement.

These tabs and their functions are discussed in greater detail later in this guide.

Course Guide

The Course Guide opens the same pages as the navigation tabs, but also provides additional
tools. To open and close the Course Guide, click the Guide bar located to the right of the Home

button.
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Open and close the
Course Guide by
clicking on this tab

The “contents” view
of the Course Guide

©
1
o | .
&

100

©

Grades
-
R@é...

ol

Film Appreciation

Course ‘ Calendar Lessons Reso!

i I

Home » Course

) L

eeXpand = collapse

o © Course
[i-] calendar -
@ Activity ¢
& +| W Lessons
@ € Resources
200
&) communicate
yReport
: 0
200
10| %
0
Contents 3
sog | What's New Grades
! Tasks
S

"‘m"mm—wm. gt A | o At

In addition to the names of the navigation tabs, the Course Guide includes the following tools:

e The Contents tool provides a course-at-a-glance view and one-click access to all course

content.

e The What’s New link displays a list of new mail messages, calendar items, content

items, and other items for the course.

e The Tasks link displays Milestones, Personal Tasks, Unread Mail, and Unread
Discussion Posts as task items you need to complete.

e The Search link lets you search calendar, content, mail, or roster entries.
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Course Tab

By default, the Course tab appears when you enter a course. This page contains several sections
that provide at-a-glance information about the course.

Fim Appreciation

Home ®» Course

0 Film Appreciation

Activity at a Glance
oy View Quick
Logons Mail Messages ! Inbox Message
200 200 View, read, and  Skip the inbox and
compose and start your
MesSsages MeSS3gE,
N - &J
E Unread Messages
0 0 Film
Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa Su Appreciation 0 messages
(101)
- som Post Subesicss
= =
Favorite director: Tarantino or
100 100 Howard?
© Tarantine O Howard
0 0
Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa Su
508 Course Announcements
« _ herear 0 e souncements
PDA Your Grade
[ Asposen. B, . “M\Wﬁ-“-w‘ﬂwv‘- g

By default, the Course tab includes the following sections:

e Activity at a Glance shows a summary of course-related activities that have occurred
during the past week, including the number of log-ins, discussion posts, mail messages,
and submissions.

e Grades displays a summary of your grades for the course.

e Course Mail provides an entry point to Course Mail. Use View Inbox to jump to your
inbox; use Quick Message to bypass the inbox and compose a new message; and use
Unread Messages to see a count of unread messages.

e Course Polls allow you to participate in any polls that are being conducted as part of the
course.

e Course Announcements displays any recent announcements that have been posted for
the course.
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Calendar Tab

The Calendar tab allows you to view course-specific schedule items for the day, week, month, or
year. To change your calendar view, click the Day, Week, Month, or Year link in the toolbar
located near the top of the tab.

“ Calendar
Sunday Monday
3 4 5
10 11 12
17 18 19
12:00a Office Hours
24 25 26

Tuesday

I Format: List Grid

| View: Day Week Month Year

Frevious Mext Todsy

February 2008

Wednesday

13

20

27
12:00a Office Hours

14

21

28

Thursday Friday

15

22

29

Ry v PR T

The Calendar tab’s toolbar contains the following options:

2

16

23

)
\

Saturday

4
k|

Calendar
controls

e The List and Grid links let you view calendar dates and events as a list or in standard
calendar grid format. When viewing calendar entries in List format, you can choose a
specific date from the small calendar navigator or choose a month and year from the

drop-down menus.

% By default, the calendar appears in Grid format.

e The Day, Week, Month, and Year links (at the right end of the toolbar) let you change

your calendar view.

e The Next and Previous links enable you jump forward to the next day, week, month, or
year, or backward to the previous time frame, depending on your current view. Click
Today to bring up the current day’s events.

¢ Inthe All Entries box (located below the calendar grid), there are links that let you view
public entries, entries made by members of a given team, or just your personal entries.
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Lessons Tab

The bulk of your instructional material is located on the Lessons tab. On this tab, your instructor
can place create lecture notes, links, quizzes, discussion forums, drop-box assignments, and other
objects. To open any content item, simply click its name on the Lessons tab.

=
Film Appreciation \“

P ————
{_Joe Smith | =

! l Lessons
expand = collapse
o OCourse My Motes | Previous Mext
[E] calendar sz'\ Discussion Ice Breaker: Great Movie Lines
J
Pl
=+ M Lessons
9/ Resources Section One
Gj Communicate
@ Report '(3-" Discussion - Section One

' | Required Reading for Section One

=7 Movie Review
.ﬂ»-' Write a Movie Review

Section Two

|f|‘ Discussion - Section Two
.4
f Greatest Actors of All Time

| Great Movies - Early 1900's to 1925
Contents )
What's New ?.E| Section Two Test
Tasks

. Search © 2008 ANGEL Learning, Inc. All rights reserved.

#mﬁﬂwu\%' bl e e .b___‘m_‘._’.mm\ P— _M st et AR e

=}

Foom i@

Pl

The Lessons tab’s toolbar contains the following options:

e The My Notes link allows you to create or view personal notes for specific content items.
e The Previous and Next links let you navigate through the lesson content.
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Resources Tab

The Resources tab provides resources that are important to your course. Your instructor and your
institution’s ANGEL administrator can make specific resources available. To access any

resource, you can simply ¢

lick the links in the appropriate section of the tab.

Fim Appreciation

expand = collapse

9 @ course

[E] calendar

+| M Lessons
& Resources
&) communicate

& Report

Contents
=08 What's New
Tasks

Q Resources 1

s —_ ¥
|,_Joe Smith | = }—

Refresh

_.
i

There are no bookmarks to display.
Course Syllabus

Institutional Resources

;
Search
@ wikipedia O wiktionary O Wikibooks
\ | [ Search | [ Fulted Search | |

i
A

Search
i eal J
Gougle | =] l
o+

PRy

pon | Search
* oo, ’m-_._m—-—-

i

H“‘#WM‘M-\“M"- M*r-—ﬁmu MJ

Typically, the Resources tab includes the following sections:

e Syllabus provides
instructor. Click th

access to the course’s syllabus, if one has been provided by the
e Course Syllabus link to open the syllabus in a new window.

¢ Wikipedia includes the standard search tools found on the Wikipedia Web site.

Wikipedia is an on

line encyclopedia that anyone can edit. The Wikipedia section also

provides access to the Wiktionary (a free wiki dictionary) and Wikibooks (a collection of
free texts written collaboratively on the Wikipedia Web site).

e Google provides the standard Web-search tools from the Google Web site.

e Course Resources includes links provided by your instructor that can assist you in your

course studies.

e Institutional Reso

urces are resources provided by your institution. These may include

links to your institution’s help desk, libraries, events, organizations, and others.
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Communicate Tab

The Communicate tab provides access to the course’s communication tools.

Film Appreciation

Comse‘l'" |L@sons|R@omﬁ Report

Home ® Course » Communicate

‘ { Toe smitn [ =)
0 _ @Cﬂmmunicate J

expand = collapse

o Course Refresh
[E] calendar - i
- fcouseva [ ineoncetious
o
1 H Lessons 2, View Inbox Quick Message There are no office hour sessions scheduled. 1
& Resources ! View, read, and compose -y Skip the inbox and 2nd 4
. messages start your message. E
&) communicate N Discussion Forums
wp Report "L 'Unread Messages Discussion Ice Breaker: Great Movie Lines i
Film Appreciation (101) 0 messages Discussion - Section One
Discussion - Section Two
Course Roster 3
View a list of people in this Course.
il
E
Course News and Events

Announcements

Read past and present Course announcements.
News

Read past and present Course news.
Polls

Take part in Course polis.
Contents

What's New
Tasks
Search

ot gt aipmatnb At o ks A 1 Al T U O N A ot (g AP o I ol

e i i aaee
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By default, the Communicate tab contains the following items:

e The Course Mail area provides access to ANGEL’s e-mail tools, so you can exchange
messages with other ANGEL users.

e Course Roster provides a list of people in the course.

e Team Files provides a space for student teams to share project files and other documents.
(This item is available only if file sharing has been enabled for teams).

e The Team Projects section provides a page describing the requirements for any team
projects. (This section is made available as needed by your instructor.)

e The Course News and Events area allows you to view course announcements, class
news, and polls.

e Live Office Hours provides a virtual office, including scheduling capabilities and a
queue manager to control student access.

e Discussion Forums are accessible through the Communicate tab, just as they are on the
Lessons tab.

Course Mail

The Course Mail tool allows students and instructors to correspond with each other without the
use of an Internet e-mail account. The Course Mail tool provides access to the HTML Editor and
Spell Checker utilities, and supports attachments. Course Mail can forward messages to Internet
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email addresses and allows the sender and recipients to monitor who has and has not read a
message.

How to Send Course Mail

To send a course mail message:
1. Log into your ANGEL course and click the Communicate tab.

You’ll see the Course Mail section of the tab, as shown in the following figure.

%y View Inbox Quick Message

. Viewi, read, and composs ‘ Skip the inbex and and start
MESSSES WOUT Message,

ol

: Unread Messages

Film Appreciation (101) 0 messages

2. Click the Quick Message link.
The Compose Message interface appears and displays the message composition window.

Course Mail > Compose Message
Return to Inbox

System Folders Ta

CHrafts (0/a)

[ inbox (o)

(3 sent (©/0) [ Remove selected recipients ]

& Trash (/o)

My Folders & Subject: | | Priority: |Norma| v|
2L EARARARI=]ERR IR R = R B R RE AR

N Tg - d5g- Stylev Fomat~ Fort= Size= fF GE -

Attachments Message Options

Attach files to this message n Send a copy to each recipient's
Internet e-mail

0 Send a copy to each recipient's mentor
if known

[ Send ][ Save Draft ][ Cancel ]

3. Click the To: button to open the Select Message Recipients dialog box.
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Select Message Redipients X
Filter Section List:
User Type To-=
Administrator, ANGEL CourseEditor
noname, julie Student
owens, chip Student
smith, joe Student
Ce-=
Beo-=
Use CTRL + click to select multiple names Remaove selected recipients
OK ] [ Cancel ]

Press and hold the Control key on your keyboard (or the Apple key on a
% Macintosh) to select multiple recipients. You may also send the message to
) students in other courses by selecting a different course from the View Section
drop-down list.

4. To select a recipient for your message, click his or her name in the left-hand pane of the
dialog box, then click the To button to add the name to the list of recipients. (Click the
Cc or Bec button to “copy” or “blind copy” the message to the selected recipient.)

Click OK to close the dialog box and return to the message window.
Click in the Subiject field and enter a subject for your message.

Select a priority from the Priority drop-down list. By default, Normal is selected.

© N o Ou

Click in the large text box and type your message. Alternatively, you can use the inline
HTML Editor to format your message.

9. Click the Send button.

Click the Attach files link if you want to add an attachment to your message.
% Select the Send a copy to each recipient’s Internet e-mail checkbox to send a

duplicate message outside the ANGEL environment to the recipients' e-mail
address. You can save a draft of your message by clicking the Save Draft
button.

How to Read Course Mail
To read a course mail message:
1. Log into your ANGEL course and click the Communicate tab.
2. Inthe Course Mail section of the tab, click the View Inbox hyperlink.
Your Course Mail Inbox appears.
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Course Mail
[ Compose New Message ] Preferences
Search: Actions: Filter:
| | [search| | Delste v |[ Go | | show Al v |[ Go |
System Folders Drag a column header and drop it here to group by that column
gDraﬂs O Mg [ @ Y From Subject Source Date
[ (?;,3 O & o ! 4 hipgo aRMtest(n  M1S2008
?y-;:::'s | o |:| =] 13 mﬂ‘ RE: Test Drop Box Ezﬁ;:p]l-eetaerrégsgi éfMB,.'ZDDB biaz22
_ (Section)

| = Weaver, Lorinda adfasdf denise1 (1) ;‘a’g lgéop[ﬁ

O =] Editor, System sdfsdfs denise1 (1) iéﬁf@gih‘l

0o & Editor, System test denise1 (1) ié{ifgglm

—— i pgP S B e
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In the Inbox, messages have the following attributes:

e New and unread messages appear in bold. After a message has been opened, it
appears non-bold.

e [Ifa message has an attachment, a paperclip icon appears to the left of the sender’s
name.

e The message’s importance is displayed in the column marked by the red exclamation
point.

To open and read a message, click the sender’s name or the message’s subject.

To return to your inbox, click the Inbox link in the list of folders that appears in the left-
hand pane of the message window.

5. You can perform the following tasks from the inbox:

e To delete a message, select the checkbox located at the left end of the message
header. Click the Actions drop-down arrow and select Delete, then click the Go
button.

% Deleted messages are moved to the Trash folder. To completely delete a
message, you must delete it from the Trash folder.

e To select all your messages, select the checkbox on the Menu icon ( E )- You can
then move the selected messages to another folder, delete them, and perform other
tasks.

e To move a message to another folder, select its checkbox, select Send to Folder
from the Actions drop-down list, then click the Go button. Select the desired folder
from the Send to Folder pop-up list, then click the Continue button. The selected
message is removed from the inbox and placed in the selected folder.

e To view a different folder, select a folder from the System Folders or My Folders
list located on the left side of the Course Mail window.

o Click the Preferences link to configure mail preferences for viewing, signatures,
editing, and privacy.
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Report Tab

The Report tab includes common course tools to help you track your course progress, grades,
and more.

=1
Film Appreciation
Course | Calend | Lessons | Resources |Oommunimtem 1

Home * Course ® Communicate ® Reports Console

O (Vep |a Reports Console

expand = collapse

9 @ course

'i Joe Smith | 5 )

| calendar Report Settings = Saved Reports
+| W Lessons Choose Report

Q Resources Category Report User(s

&) communicate |LearnerProﬁIe v||Ac1i\ﬂ'ty Logs v|u Smith, Joe v

@ Report Configure Report -1 Collapse
Starting | 2 days ago v = Ending before E
Select report view [ Print Preview ] [ Send Report ] [ Expaort ]
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@ Contents 82008 Pz0ng Setns
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spa | Search
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The default reports include the following:

e Learner Profile provides an analysis of your activity, submissions, and grades, and can
compare them with the class average. Your learner profile also includes a place to store
personal notes about the course.

e Grades allows you to check your grades for all assignments (both online and off-line
assignments) and provides a cumulative grade at any point of the semester.

e Milestones tracks your progress on key course objectives and assignments.
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Common Tasks
The following sections explain the procedures for performing common tasks in ANGEL.

How to Log into ANGEL
To log into ANGEL.:

1. Onthe ANGEL home page, type your username and password in the appropriate fields.

Log On

Username||
Password
Language | English (United States) »

I forgot my password
Request an account
Request a Mentor Insight Window account

--.-1..‘__*-_-‘\ _*_“_M-\_.*-_“

2. Click the Log On button.

Click the I forgot my password link to have an e-mail message sent to you in
order to reset your password. If you don’t have an account, click the Request
o7 an account link to request a username and password for the system. The
¥ password reminder and account request options are not available at all
institutions. For information regarding how to request an ANGEL user account,
contact your institution’s support desk

How to Forward Course Mail

By default, users must log into ANGEL to send or read course mail messages. You can optionally
configure ANGEL’s course mail forwarding settings to automatically forward course mail to an
Internet e-mail address.
Course mail forwarding is a global setting. Therefore, enabling course mail
% forwarding forwards all course mail messages received in any course or group
for which you are enrolled.
To forward your ANGEL course mail to an Internet e-mail account:

—

(

x/ ) in Power Strip.

1. Log into ANGEL and click the Personal Settingsicon (
The Preferences page appears.

2. Click System Settings in the General User Settings area. The System Settings page
appears.
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ANGEL 7.3

Home Preferences System Settings

Joe Smith | }

System Settings

User Level
Directions: Select the option below that best describes your level of comfort with the system, Choosing a higher-level provides less and exposes more
advanced features of the systam.
@ Unspedified
You have not specified a user level. Please choose one of the following options.

 Beginner

This option provides helpful notes and descriptions of most links throughout the environment.

 Intermediate
This option eliminates most of the link descriptions making the pages more compact and easy to navigate.

O Advanced
This option removes link descriptions and makes advanced settings more accessible by starting editors in Advanced mode.

0,0:0.0,6

Local Drive Settings

Directions: Some content in some courses and groups may be stored on compact discs or installed on another drive on your computer. The following
settings allows you to specify which drive letters your computer uses for each of the local drive types. Set each of the options below to match the
configuration of the computer that you will be using to access the site.

CD ROM [defautt ||

Floppy Drive [defaul | +||

|
DVD ROM  [defaut ¥ || |
|
|

Hard Drive [defaut ||

Mail Settings
Directions: You can have a copy of mail that you receive in your courses and groups forwarded to an Internst e-mail account. Simphy enter the e-mail
address below and specify a forwarding mode.

Forwarding Address

Forwarding Mode
| Do not forward my mail

3. Locate the Mail Settings area, click the Forwarding Address field, and type the full e-
mail address where your ANGEL mail should be sent.

Mail Settings

Directions: You can have a copy of mail that you receive in yo
address below and specify a forwarding mode.

Forwarding Address

|
L Al | et

4. Click the Forwarding Mode drop-down list and select the forwarding mode of your
choice.
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Mail Settings

Directions: You can have a copy of mail that you receive in
address below and specify a forwarding mode.

Forwarding Address
|juesm'rth @bigschool edu

Forwarding Mode
Do not forward my mail "

Do not forwand

Forward my mail and keep as new
| Farward my mail and mark as read
Forward my mail and delete
*\_—l""-

-

w‘#.r--»

5. Click the Save button.

How to Take an Assessment

Your instructor can create several kinds of online assessments, including quizzes, tests, and
surveys. An assessment can include images or other multimedia elements, as well as various
types of questions (multiple choice, essay, fill-in-the-blank, etc.). The following steps apply to
taking a quiz, test, or survey.

To take an assessment:

1. Log into your ANGEL course and click the Lessons tab.
2. Navigate to the assessment you want to take and click its icon or title.

An instruction page appears.
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Course | Calend | E5SONS

Home * Course ® Lessons ™ Section Two Test

‘i Joe Smith | ¥

A

= section Two Test

expand ® colapse

9 OCDUI'SE My Motes | Previous Mext
[ calendar Instructions
+| M Lessons
@ Resources = This assessment is not tied to a gradebook assignment No submissions have been
) ¢ Maximum number of attempts: 1 recorded for this assignment
&) communicate » Time limit: Unlimited minutes
& Report « Review mode: Full Submissions for this
assignment will appear in this
drea
@ Contents
soe | What's New
! Tasks
Search © 2008 ANGEL Lezrning, Inc. All ights reserved,

-~EP:~.4....-4._,__ P, r-m_wmwmru“-‘-—»‘wxw*“m*#.‘m

3. Click the Begin Now button.
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The assessment appears on the screen.

(

Fim Appreciation

Course | Calendar l/-: Resources | Communicate Report

Y

Home * Course * Lessons * Section Two Test

() [

expand @ collapse

'C Joe Smith =:

= Section Two Test

o @ course My MNotes | Previous Mext {
@ [E] calendar :
+| W Lessons
€& Resources 1. What is the name of the technique where all images within frame are sharply visible? ¢
&) communicate O n) Deep focus
0 wReport O B) Fancy focus

O C) Full focus

O O D) Hocus focus

N

2. What is the least number of frames of film per second that are required to simulate fluid motion when
projected on screen?
QOa)y12
OB)24
Cic)3s
Op)4s g
{
4
submit | [ Save and Continue Later
@ | contents 3
ste | What's New 3
Tasks
o Search ® 2008 ANGEL Learning, Inc. Al rights reserved. L
B T T e e T TUII o VRS Y _..t"‘-“““"J

If your instructor has imposed a time limit on the assessment, the amount of time
remaining is displayed in the upper right corner of the assessment.

Time
Assessment: 00:07:15

4. Select a choice or provide a response for each question.

ANGEL attempts to automatically grade fill-in-the-blank question types based
% on an instructor-provided answer key. It is important to answer fill-in-the-blank
question types as concisely as possible.

5. When you have answered all of the questions, scroll to the bottom of the page and click
the Submit button.

A pop-up message asks you to confirm that you’re really ready to submit the assessment
for grading.
If the instructor has imposed a time limit on the assessment, you may receive a
% pop-up warning message when your time is about to expire. If you do not

submit the assessment before your time expires, a message appears asking you
to submit the assessment. If the instructor has configured the assessment to
auto-submit when time expires, the assessment automatically submits when you
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click the OK button.

6. Click the OK button to submit the assessment.

A results/confirmation page appears on the screen.

&

Your instructor determines the amount of information that appears on the
confirmation screen. This may include any combination of questions, responses,
answers, score, instructor comments, and more.

How to Post a Message to a Discussion Forum

Threaded discussion forums allow you to post, reply to, and search messages from the instructor
and other students.
To post a message to a discussion forum:

1. Log into your ANGEL course and click the Lessons (or Communicate) tab.

2. Navigate to the discussion forum you want to post to and click its icon or title.

The discussion forum appears on the screen.

" Discussion Ice Breaker: Great Movie Lines

Settings Reports Utiities Delete Print My Notes Previous Next
= New Post Thresded View |v Navigate: 14| < | Aiposss N ’_1_]" _I_l_l'ﬂ |7
New Post
button Directions ( hide | new window )

This is your first discussion assignment (and an easy one at that). Everyone must: e

e Add three separate entries to the discussion
o You must include one of your favorite movie lines
o Tell why it is funny/interesting
* Reply to at least three entries <
+/- Subject Flag Score  Author Posted Replies  Rating
This is steve's topi - Six Instructor 2/8/2008 | 10:55AM 0 Al
Elf -- Pocket Mathew  2/7/2008 | 3:16 PM 0
* Princess Bride = Three Instructor 2/6/2008 | 2:20 PM 2
Aliens -~ One Instructor 2/6/2008 | 8:57 AM 0
Hot Fuzz == Cage Nick 2/5/2008 | 9:20 AM 0
Office Space - Cage Nick 1/31/2008 | 10:46 AM 0
# Monte Python -- Felton Tom 1/30/2008 | 5:05 PM 2
+ James Bond -- Felton Tom 1/30/2008 | 2:08 PM 2
Hudsucker Proxy -- Kingsley Ben 1/30/2008 | 11:03AM 0O
R e S

3. Click the New Topic button.
The Post a New Message window appears.
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-!I' R . . R
.~ Discussion Ice Breaker: Great Movie Lines

Settings Reports Utilities Delete Print My Motes Previous MNext
Directions: This is your first discussion assignment (and an e... ( show | new window )
New Post
Post Subject | |
- A = == ¥~ Fort~ Sizev ‘5 GE|

Attachments (add a file)

Advanced message options

[ Sawve ] [ Cancel ]
4. Click in the Topic field and enter a topic for your message.
5. Click in the Message field and type your message.

0" To attach a file to your post, click the add a file link, which appears under the
i Message field.

6. When your message is finished, click the Save button.

How to Post to Live Chat

Live Chat supports real-time communication between students and instructors. If the feature is
enabled, users can view a log of previous chat conversations by clicking the View Logs link,
located below the hyperlinked chat room title.

To post to Live Chat:

1. Log into your ANGEL course and click the Communicate tab.
2. Navigate to the Live Chat you want to join and click its title.
The Live Chat interface appears on the screen.
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Chat
Hailey Longardner: | Online Users
Hello, Samantha - nice to sea you = Hailey Longardner

Samantha Swenby: Samantha Swenby

I think I'min.
Hailey Longardner:
Did you have any questions concerning the mid-term exam?

|
E

3. Type a message in the empty text box (located at the bottom of the screen) and click
Send.

Click the Options hyperlink to adjust the font color and message scroll options.
When complete, click the Save Options hyperlink.

How to Submit an Assignment to a Drop Box

Uploading electronic files to a drop box is a convenient way to submit assignments to your
instructor. The Drop Box accepts virtually any type of electronic file, including word processing
documents, images, Web pages, and others.
When uploading electronic files from a Macintosh computer, it is important to
% add the proper file extension to the file name (e.g. .doc, .jpg, .htm, etc.) before
uploading the file.
To submit an assignment to a drop box:

1. Log into your ANGEL course and click the Lessons tab.

2. Navigate to your drop box and click its title or icon. The dropbox page appears.
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Fim Appreciation

Home * Course ® Lessons ® Movie Review P ahmgmera o
{_Joe Smith | = }

Map

=
| . ]
mexpand = colapse = Movie Review

Write 3 Movie Review
@ course
My Motes | Previous Mext

[E] calendar
+] W Lessons Review: Full, Anomymaus: Na

€& Resources Instructions: Enter or paste your written work and/or click "Attachments" to upload your files.
&) communicate

wReport

Title

HTML Editar 1

:

User Review Enabled 4
‘ Subjea‘| Grade (100 pts)| Comments

@ Contents

soe | What's New

! Tasks
PDA Search © 2008 ANGEL Learning, Inc. Al rights reserved.
B R R e Aot . s AU s A A e s 0 s G ARIINAS R o Ml o,

3. Enter a Title and Message for your submission.

4. Click the Attachments button to locate and add one or more file. The attachments
window appears.
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Attachments

Upload a File
| | Browss... |

[ Upload File ][ Dragn-Drop

Uploaded Files

'WM*-“'#‘“H—#."“"

5. Click the Browse... button, locate the file you want to upload, and click Open. You are
returned to the attachments window.

6. Click Upload File.

The file you selected is added to the Uploaded Files section. Repeat this process to
upload multiple files.

7. When you’ve uploaded all the files you need, click the Finished button. You are returned
to the Dropbox page; the files you uploaded are displayed.

8. From the Dropbox page, if you’re ready to turn your work in, click the Submit button.

% If you need to delete files youve uploaded before submitting, click the
Attachments button, select a file, and click Delete.
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How to Use the Inline HTML Editor

ANGEL’s editor is a full WYSIWYG (what you see is what you get) HTML Editor specifically designed to work within the ANGEL LMS. The
editor is present any place text can be formatted or edited.
Notable features include:

Full WYSIWYG editing is available everywhere you can edit content within ANGEL.
Simple menu options allow you find and link to any other content item within your course or the World Wide Web.

The Insert Image tool features an integrated file/Web browser with the ability to select a graphic, seamlessly upload it to the course, and then
insert the image into the document.

Content template support allows for the creation of course content with a consistent look and feel.
Integrated equation editor from industry-leader WebEQ

Full table support makes it easy to present complex tabular data.

Paste from MS Word feature allows you to paste into your HTML Editor directly from MS Word.

Edit window automatically resizes as you enter text, allowing the window to start small and expand dynamically as you add text.

Accessing Menus

The HTML Editor is a toolbar that contains a menu of tools to help you enhance your pages within ANGEL. The editor has three modes that are
implemented to best support the user’s current task:

36

Full Menu — The menu bar with all 32 menu features active.

Partial Menu — The menu bar with 16 menu features active. Available in ANGEL’s Announcement Editor, Page Banner, Data Management
nugget, Page Folder, Institutional Resource nugget, Did You Know nugget, About This Section nugget, Course News and Events nugget, and
Syllabus nugget.

Slim Menu — The menu bar with 13 menu features active. Available in ANGEL’s Calendar feature.
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The HTML editor includes the following menus and tools:

" A - A= - A0 08 3 =1 [ R 4 - - v Tg~ &g~ Sylev Fomatv Fontr Sizew % 5 ~
A B C D E F G H | J K L M N
Letter Menu/Tool Description Full Partial Slim
A Collapse/Expand Allows you to hide the HTML Editor toolbar
toolbar arrow
Macro Icon Allows you to create and edit macros. v v
C Edit menu Allows you to cut, copy, paste, undo/redo, find, v 4
replace, select all and remove.
D Font Style menu Allows you to bold, underline, italicize, Bold, italic and Bold, italic and
strikethrough, superscript and subscript text. underline only underline only
E Link menu Allows you to enter content and web links, Content link, web link | Content link, web link
remove links and create anchors. only only
F Media menu Allows you to insert and format images, movies Images
and Flash presentations.
G Insert menu Allows you to use an HTML Widget, create and Equation editor and Equation editor only
modify equations, insert special characters, use special characters
the universal keyboard, insert lines and page only
breaks.
H Table menu Allows you to manipulate rows, columns and
cells.
| Form menu Allows you to create forms using elements such
as buttons, text fields and form parameters.
J List menu Allows you to add bullets, numberings and Numbered and Numbered and bulleted
indents. bulleted only only
K Justify menu Allows you to justify your text either left, right,
center or block.
L Text & Background Allows you to change your text and background
color colors.
M | Formatting & Styles Allows you to change your styles, fonts, font size Font and Size only Font and Size only
arrow and format your text.
N File Menu Allows you to view HTML source code, spell Spell check only Spell check only

check, preview, save or change document

37

How to Use the Inline HTML Editor




ANGEL® 7.3 Student essentials Guide

| | | properties. | | |

A You will need to enable pop-ups to use some tools in the HTML editor. Failing to enable pop-
ups may result in loss of information in the HTML editor.
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